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Nikada nismo čuli da je neko rekao „Reč vre-
di kao hiljadu slika“ (obrnuto od poznate 
izreke), ali se u Photoshopu može postići to-
liko mnogo umetničkih efekata sa tekstom 
da se linija između slika i reči može zama-
gliti – ponekad čak i doslovno! U ovom pogla­
vlju naučićete kako da napravite izmenljiv tekst, i kako 
da ga potom stilizujete i formatirate korišćenjem širo­
kog spektra kontrola za znakove i pasuse. Upoznaćete 
i specijalne tehnike, kao što su one za transformisanje 
teksta, prikazivanje posvetljene pozadine kroz tekst 
(kao na slici desno), rasterizovanje teksta (pretvaranje 
u piksele) i dobijanje efekta isečenog papira. Na kraju, 
saznaćete kako da neke tekstualne oblike smestite u 
kanal za posebnu (štrih) boju.

Kada koristite alatku Horizontal Type ili Vertical 
Type, u dokumentu se pojavljuje izmenljiv tekst, a na 
panou Layers – nov sloj. Lako možete promeniti atri­
bute izmenljivog teksta, kao što su porodica, stil i veli­
čina fonta; međuslovno rastojanje, prored, poravnanje, 
pomeraj od osnovne linije; i boja. Osim toga, izmenljiv 
tekst možete transformisati, izobličavati ili na njega 
primeniti efekte sloja; promeniti mu režim mešanja, 
neprovidnost i popunu. Za primenu stilova na tekst, 
možete koristiti pano Character  A, pano Paragraph, 

 pano Glyphs,   ★ pano Paragraph Styles,   pano 
Character Styles    i traku Options.

Porodica 
fontova

Kerning

Vertikalna 
dimenzija

Pomeraj 
osnovne linije Stilovi teksta

OpenType 
opcije 

Jezik
Metoda 
umekšavanja 
ivica

A Atribute s panoa Character možete do-
deljivati celokupnom tekstu na sloju ili samo 
izabranim znakovima ili rečima.

Veličina 
fonta

Stil fonta

Prored

Treking

Horizontalna 
dimenzija
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B Uz isključeno 
umekšavanje,  
ivice teksta deluju 
nazubljeno.

C Uz uključeno 
umekšavanje,  
ivice teksta su 
glađe.

A Traka Options nudi mnoge kontrole za alatke za tekst.

Birač Tool Preset

Orijentacija teksta Porodica fontova Stil fonta Veličina fonta Poravnanje

Metoda umekšavanja ivica

Prikazivanje ili sakrivanje grupe 
panoa Character i Paragraph

Boja teksta

Izobličavanje 
teksta

Izrada izmenljivog teksta
Možete biti opušteni u pogledu mesta na koje po­
stavljate izmenljiv tekst na početku i toga koje tipo­
grafske atribute birate za njega, zato što te atribute 
možete lako promeniti, a slojeve možete premestiti, 
transformisati ili im promeniti redosled. 

Napravite sloj za izmenljiv tekst:
1.	 Na panou Layers,   pritisnite sloj iznad kojeg 

želite da se pojavi sloj za tekst.

2.	 Izaberite alatku Horizontal Type  ili Vertical 
Type  (T ili Shift-T). 

3.	 Na traci Options,A uradite sve ovde navedeno:

	 Izaberite porodicu fontova, a iz susednog me­
nija izaberite stil fonta. Primer svakog fonta pri­
kazuje se u meniju.

	 Izaberite ili unesite veličinu fonta (možete kori­
stiti ribajući klizač).

	 Izaberite metodu umekšavanja ivica, tj. način 
na koji Photoshop uvodi delimično providne 
piksele duž ivica znakova kako bi oni delova­
li glađe. Za potrebe štampanja, izaberite opciju 
Sharp (najoštrije), Crisp (donekle oštro), Strong 
(jače) ili Smooth (najglađe). Za objavljivanje na 
vebu, izaberite opciju umekšavanja koja omo­
gućava da se tekst iscrtava na vašem sistemu 
tako da više odgovara iscrtavanju u čitaču veba. 
Za Safari u Mac OS-u, izaberite opciju Mac LCD 
ili Mac; za Internet Explorer u Windowsu, iza­
berite Windows LCD ili Windows. LCD opcije 
iscrtavaju tekst uz potpikselsko umekšavanje 
(osenčeni pikseli koji se dodaju oko znakova da 

bi znakovi izgledali jasnije). Imajte na umu da 
su u Photoshopu potpikseli u sivim tonovima, 
dok ih Safari i Internet Explorer prikazuju u RGB 
boji.B–C

	 Pritisnite dugme za poravnavanje da biste sti­
lizovan tekst (engl. point type) poravnali u od­
nosu na prvobitnu tačku umetanja ili poravnali 
tekst u pasusima (engl. paragraph type) s levom 
ivicom, desnom ivicom ili ga centrirali unutar 
graničnog okvira (videti i stranu 394).

	 Pritisnite uzorak Text Color, pa izaberite boju 
preko Color Pickera ili panoa Swatches, ili priti­
snite neku boju u dokumentu pa pritisnite OK.

4.	 Uradite jedno od sledećeg:

	 Da biste napravili stilizovan tekst (pogodan za 
male količine teksta), pritisnite van postojećeg 
teksta u dokumentu da zadate tačku umetanja, 
pa unesite tekst. Možete pritisnuti Enter/Return 
da biste prelomili redove tamo gde je potreb­
no, kako biste sprečili da tekst nestane s platna. 
(Tekst možete pomeriti i kasnije, alatkom Move.)

	 Da biste napravili tekst u pasusima (pogodan 
za veće blokove teksta), povucite mišem da de­
finišete granični okvir u koji ćete smestiti tekst, 
pa unesite tekst. Neka se reči prirodno prelama­
ju na ivici graničnog okvira – pritiskajte Enter/
Return samo kada treba da započnete nov pa­
sus. Napomena: Ako više volite da prvo zadate 
dimenzije graničnog okvira, držite Alt/Option i 
pritisnite u dokumentu, pa unesite dimenzije u 
okvir za dijalog Paragraph Text Size.
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A Nakon što smo otkucali 
„EcoStorage“, pritisnuli smo 
Enter/Return da bi sledeća 
reč prešla u drugi red.

B Slojevi za izmenljiv tekst imaju ikonicu na 
umanjenoj verziji i dodeljeno im je ime jednako 
prvoj reči ili prvih nekoliko reči teksta na datom 
sloju.

koristite tipografske navodnike!
Tipografski navodnici i apostrof oblikovani su tako 
da odgovaraju početku i kraju navoda i skraćenica. 
Da biste ih koristili u Photoshopu (što svakako pre­
poručujemo), izaberite Preferences > Type i potvr­
dite opciju Use Smart Quotes. Ravne navodnike i 
apostrof treba koristiti samo kao oznake za inče i 
stope – ukoliko vam zatrebaju.

Uvoženje illustratorovog teksta 
kao pametnog objekta
Radi brze obrade, uvezite tekst iz Illustratora u 
Photoshopov dokument kao pametan objekat (vi­
deti metode na stranama 271, 273, 274 i 280). Kako 
se menja pametan objekat, opisano je na strana­
ma 276 i 281.

5.	 Da biste prihvatili nov tekst, pritisnite Esc ★ ili 
taster Enter na numeričkoj tastaturi (ne na glav­
noj) ili pritisnite dugme Commit   na desnom 
kraju trake Options. (Da biste otkazali tekst, pri­
tisnite dugme Cancel  na traci Options.) Kad 
god napravite nov tekst alatkom Horizontal 
ili Vertical Type, on se pojavljuje na novom 
sloju.A–B

	 Napomena: Da biste koristili taster Esc kao pre­
čicu za komandu Commit, opcija Use ESC Key 
to Commit Text mora biti potvrđena na panou 
Type u okviru za dijalog Edit/Photoshop  CC > 
Preferences. ★

➤➤ Photoshop koristi vektorske konture za odre­
đene porodice i stilove fontova kada promeni­
te veličinu izmenljivog teksta, snimite datoteku 
u format PDF, ili je pošaljete na PostScript štam­
pač. Poput vektorske grafike, i izmenljiv tekst se 
štampa u rezoluciji štampača, a ne u rezoluci­
ji datoteke.

➤➤ Možete desnim tasterom pritisnuti stavku 
izmenljivog teksta na panou Layers i izabrati 

metodu umekšavanja ivica iz kontekstnog me­
nija. Novo podešavanje će se prikazati u meniju 
Anti-Aliasing na panou Character.

➤➤ Kako da prikažete opcije East Asian Features ili 
Middle Eastern Features na panoima Character 
i Paragraph i u njihovim menijima, opisano je u 
odeljku „Oblast Choose Text Engine Options“, 
na strani 469.

➤➤ Da biste granični okvir za tekst brzo popuni­
li lažnim tekstom, izaberite Type > Paste Lorem 
Ipsum. Kako se radi s tekstom koji se ne vidi jer 
ga ima previše, opisano je na strani 398.

➤➤ Ako postavite rečenice, reči ili znakove na za­
sebne slojeve, moći ćete da ih pojedinačno 
premeštate, poravnavate i na njih primenjuje­
te efekte. Da biste organizovali više slojeva s 
tekstom, smestite ih u grupe slojeva. Ako že­
lite da na panou Layers prikažete samo sloje­
ve za tekst, izaberite opciju Kind iz menija Filter 
Type na vrhu panoa, pa pritisnite dugme Filter 
for Type Layers. 
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Biranje teksta
Da biste mogli da menjate atribute znakova ili pa­
susa, ili sadržaj teksta, morate izabrati sloj za tekst ili 
određen niz znakova ili rečenica.

Napomena: Da biste na tekst primenili neke vrste 
obrade – kao što su filtri ili potezi četkicom – mora­
te ga prvo rasterizovati (strana 400). Nakon što se 
tekst rasterizuje, njegovi atributi znakova ili pasusa 
(npr. font i prored) ne mogu se menjati.

Izaberite tekst da biste ga obradili  
ili mu promenili stil:
	 Uradite jedno od sledećeg:

	 Pritisnite sloj za tekst, odaberite alatku 
Horizontal Type  ili Vertical Type  (T ili 
Shift-T), pa prevucite preko nekih znakova ili 
reči da biste ih izabrali,A ili pritisnite dvaput, tri­
put ili četiri puta, kao što je opisano u izdvoje­
nom odeljku na ovoj strani.

	 Dok je izabrana bilo koja alatka, dvaput pritisni­
te ikonicu  na panou Layers. Sav tekst na tom 
sloju postaje izabran. Da biste smanjili selekciju, 
povlačite mišem ili pritisnite dvaput ili triput.

	 Da promenite atribute celog teksta na datom 
sloju preko panoa Character ili Paragraph – re­
cimo, veličinu fonta, prored ili poravnanje – 
samo pritisnite sloj (ne morate aktivirati alatku 
za tekst). 

➤➤ Ako želite da obrišete znakove koje ste izabrali, 
pritisnite Backspace/Delete. Da obrišete samo 
jedan po jedan znak u horizontalnom tekstu, 
alatkom za tekst pritisnite desno od znaka koji 
ćete obrisati, pa pritisnite Backspace/Delete (za 
vertikalan tekst, uradite isto, ali pritisnite ispod 
znaka).

Izađite iz režima menjanja teksta:
	 Kada završite s menjanjem teksta, uradite jedno 

od sledećeg: 

	 Pritisnite dugme Commit  na traci Options.

	 Pritisnite Esc ★ ili taster Enter na numeričkoj 
tastaturi (ne na glavnoj).

 	 Pritisnite neku drugu alatku.

	 Pritisnite neki drugi sloj. 

	 (Da otkažete izmene pre nego što ih potvrdite, 
pritisnite dugme Cancel  na traci Options.)

Prikazivanje panoa Character
➤➤ Ako je pano Character otvoren ali sveden na 

ikonicu, pritisnite ikonicu .

➤➤ Izaberite alatku Horizontal Type ili Vertical 
Type, pa pritisnite dugme Toggle Character and 
Paragraph Panels  na traci Options.

➤➤ Izaberite Type > Panels > Character Panel ili 
Window > Character.

Biranje znakova teksta
Da biste izabrali tekst radi korekture ili promene sti­
la, izaberite alatku Horizontal Type ili Vertical Type, 
pa uradite nešto od sledećeg:

Izaberite susedne 
znakove ili reči

Povucite preko njih. Ili pri­
tisnite na početku niza 
reči, pa držite Shift i priti­
snite njegov kraj.

Izaberite reč Dvaput pritisnite reč.

Izaberite sused­
ne reči

Dvaput pritisnite reč, pa 
povlačite ne puštajući ta­
ster miša.

Izaberite red 
teksta

Triput pritisnite red teksta.

Izaberite pasus 
teksta

Četiri puta pritisnite unu­
tar pasusa.

Izaberite sve zna­
kove u tekstual­
nom objektu

Dvaput pritisnite ikonicu 
 na panou Layers; ili pri­

tisnite unutar teksta, pa 
pritisnite Ctrl-A/Cmd-A.

A Da biste izabrali znakove teksta koje 
treba da izmenite, povlačite preko njih 
alatkom za tekst.
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Menjanje boje teksta
Promenite boju celokupnog teksta 
na sloju za tekst:
1.	 Na panou Layers, pritisnite sloj za tekst.

2.	 Uradite jedno od sledećeg:

	 Izaberite alatku Horizontal Type  ili Vertical 
Type,   pa pritisnite uzorak Text Color na traci 
Options.

	 Na panou Character   pritisnite uzorak Color.

3.	 Izaberite boju preko Color Pickera ili panoa 
Swatches, ili pritisnite neku boju na slici, pa pri­
tisnite OK da biste izašli iz Color Pickera.

➤➤ Na sloj za tekst možete primeniti i boju, preliv 
ili šaru, korišćenjem izmenljivog efekta Overlay 
(strane 410–411).

Promenite boju izabranih znakova 
ili reči:
1.	 Alatkom Horizontal Type  ili Vertical Type   

izaberite znakove ili reči kojima menjate boju. 

2.	 Uradite jedno od sledećeg:

	 Na traci Options pritisnite uzorak Text Color.

	 Na panou Character   pritisnite uzorak Color.A
3.	 Pratite gore naveden korak 3.B

A Alatkom za tekst prevlačite preko  
znakova kojima ćete promeniti boju,  
a zatim pritisnite uzorak Text Color na  
traci Options.

B Izaberite zamensku boju iz birača boja.

Nastavak na sledećoj strani

Menjanje porodice i stila fonta
Promenite porodicu i stil fonta:
Metoda 1 (izaberite iz kompletne liste)
1.	 Izaberite tekst koji ćete restilizovati (upotrebite 

bilo koju metodu s prethodne strane). 

2.	 Na panou Character  ili na traci Options, priti­
snite strelicu menija Font Family da bi se pri­
kazala klizna lista dostupnih porodica i stilova 
fonta. 

	 Da biste pregledali listu, nemojte pritiskati ta­
ster miša već pritisnite taster sa strelicom nago­
re ili nadole na tastaturi; fontovi će se prikazati 
u dokumentu. 

	 Na sledeću porodicu fontova preći ćete ako dr­
žite Shift i pritisnete strelicu nagore ili strelicu 
nadole. 

3.	 Da biste primenili font i izašli iz panoa, pritisni­
te ime fonta; a da biste primenili trenutno istak­
nut font, pritisnite Enter/Return.

➤➤ Ako izabrani tekst već sadrži željenu porodicu 
fontova i hoćete da promenite samo stil, može­
te koristiti oblast Font Style na panou Character 
ili na traci Options. 

➤➤ Iz podmenija Type > Font Preview Size možete 
odabrati veličinu (npr. Medium) za uzorke poro­
dica fontova koji se prikazuju u Photoshopovim 
menijima za fontove. Napomena: Ukoliko vam 
se uzorci prikazuju presporo, izaberite manju 
veličinu za prikaz ili opciju None.


